CPS Directions
Making a Desktop Folder
1. Right click on desktop or go to "My Computer" and change the drop down menu to
desktop.
2. Click on "Make a new folder."
3. Name the desktop folder. (Ex. Everything CPS folder)
4. In the future, save all things for CPS (CPS database, photos, PowerPoints, ExamView
files, etc.) in this folder.
Creating a Database
You only really need to create a database once:
1.
2.
3.
4.
5.

Make sure you are connected to the Internet and on your school computer.
Open CPS by double clicking on the CPS icon.
Choose to set up a new database. Follow the prompts.
Name the new database. (Your last name and CPS, for example: MartinCPS)
Save this database to your folder on the Desktop or C:Drive. (This is important to
avoid possible file corruption. Always save all files in use with CPS to the same
Desktop folder or C:Drive).

Creating a Class
If you switch classes or are departmentalized, you will need to create a class for each of the
sections of students you teach. (For example, Math 5A and Math 5B or Block 1 Pre-calculus). If
you are a self-contained classroom, you will only need to create one class.
1.
2.
3.
4.

Click "Prepare" tab.
Click "Classes and Students."
Click the green plus sign and choose "Class."
Follow the directions on the screen.

Adding Students
1. Click the name of your class.
2. Click the green plus sign and choose new "Student."
3. Repeat this process until you have enough students in your class or press enter on your
keyboard to add as many students as necessary.
4. Rename your students by changing the "first name" and "last name" fields.
(Note: You can add new students and delete withdrawn students as needed in the
future. In addition, if a "clicker" becomes inoperable you can change the clicker number
for a student by selecting the appropriate box and changing “Pad ID.”)

Adding PowerPoint or ExamView files
1.
2.
3.
4.
5.

Click "Prepare" tab.
Click "Lessons and Assessments."
Go to "Add File(s)" located to the right in the second blue block.
Choose the drop down menu for PowerPoint or ExamView.
Navigate to where you saved the PowerPoint or ExamView file on the C:Drive or
desktop and click "Open."

Creating CPS Lessons and Questions
1.
2.
3.
4.
5.
6.
7.
8.

Click "Prepare" tab.
Click "Lessons and Assessments."
Click the green plus sign and choose new "Lesson."
Add a title to your lesson.
Click on the name of your lesson while still under the Prepare tab.
Click the green plus sign and choose new "Question."
Save each question as you go with the floppy disk and arrow icon.
Click the red close icon when you are finished creating questions.

Engaging a Lesson
1. Click the "Engage" tab.
2. Check the box or boxes in front of the lesson you want to engage.
3. If you have multiple classes, make sure you have chosen the desired class in the middle
blue box.
4. Click the green "Engage" button to start your lesson.
5. "Take Attendance" by clicking on the "Class" button to see if all of the clickers are
working.
6. If the lesson is CPS created or ExamView, use the "Next #1" button. If the lesson is a
PowerPoint, click the "Verbal" button.
Chalkboard Questions
This option allows you to create questions with the CPS Chalkboard. You can do this
spontaneously while you are engaged in a lesson or create the Chalkboard questions before
you engage.
1. While you are “engaged” in a lesson, click “Chalkboard.”
2. This will open up the Chalkboard template where you can create your question.
3. Use the Pencil button to write your question. Click the Answer button to show the
question and enter an answer stem. (Change the answer type at the bottom of the
screen).
4. Click Start.
5. Click End.
6. Click Close to save the performance data.

Verbal Questions
You can spontaneously ask questions in class and still record performance data.
1. On the “Engage” tab, select your database by clicking on it. Then click “Engage: Verbal”
at the top.
2. In the set up window that appears, check over the options to make sure they meet your
specifications and click “OK”.
3. The CPS toolbar will appear at the top of the screen. Click the “verbal” button to identify
the question format for your first question (True/False, Yes/No, A/B, etc.)
4. The question will start automatically. After the students submit their answers, click
“End”.
5. The charting window will appear to show how the class responded. Next to the “correct
answer” window, choose the correct answer from the list. The correct answer will
highlight green on the chart. The incorrect answers will highlight blue on the chart.
6. To change the format of your verbal question, click the appropriate button (T/F, Y/N,
A/B) from the toolbar before going to your next question.
7. When you are finished with your verbal questions, click “Close.”
Student Managed Assessment (Handouts)
A student managed assessment is where the student has a paper copy of the test on his or
her desk, and the answers are submitted with the CPS system. This method of delivery
allows students to work at his/her own pace. You might want to advise students to complete
answers on the paper copy as well.
1. Click the “Prepare” tab and then “Lessons and Assessments”. Click the green “+ New”
button and “Fast Grade Lesson”. You will need to give the lesson a title (Example: Math
Facts Handout) and click “OK”.
2. By entering the answers ahead of time, CPS will score the assessment for you. The
window that appears allows you to do this.
3. For question one, go to the window that has the correct question format (Y/N, T/F, A/B,
A/B/C, etc) and click the correct answer. You will see the “Current Question #” window
change to reflect you are now on question “2”.
4. Select the correct question format (Y/N, T/F, A/B, A/B/C, etc) and click the correct
answer. You will see the “current question” window change to reflect you are now on
question “3”. Repeat this process until you have entered all of the answers. Click “OK”
at the bottom of the window.
5. You will see your “Fast Grade” lesson added to your assessments on the “Prepare” tab
and the “Engage” tab. Check the box before your “Fast Grade” lesson in the “Engage”
tab.
6. Click “Assessment Setup” from the blue toolbar. Choose “Student Paced”. Click
“Engage: Assessment”.
7. A screen will appear showing the student pad numbers in the blue fields and the
question they are currently working on in the yellow fields. As the students work through
the problems, the question number will change under their pad number.
8. When the student has finished the assessment, the fields will remain solid blue to show
they are done. When everyone has finished, click “Done”.
Note: With IR clicker pads, buttons F-H have special functions in Student Paced mode.
Students can use only buttons A-E to answer questions or MC5 in Student Paced mode.

Accessing Reports
1. Click on the "Report" tab.
2. Click on the Session Title you would like a Report for--note that the most recent one is
located at the top of the list.
3. Click on "Generate."
4. Select or deselect students you want the Report to include.
5. Select your Report and click "Preview." (Reports of interest include: "Instructor
Summary," “Question Report,” “Question Analysis,” and "Study Guides-Incorrect
Answers.")
6. Print the Report or close out of it.

Online Resources

Download CPS for PC Full Release at home:
http://www.einstruction.com/support_downloads/downloads.html
Ask your Tech Coordinator to download the software on your computer at
school.
http://www.einstruction.com/support_downloads/legacy.html (Note: 5.4 is an
old but reliable version)
Training Resources and Materials (videos)
http://www.einstruction.com/support_downloads/training/resources/index.html
Notes
If your computer does not recognize the receiver, you may not have connected the receiver to the
computer before opening the CPS software. To fix this: check Settings > Delivery Options > Receiver >
Detect CPS Receiver.

Create a CPS Challenge Board
Create a Jeopardy type quiz game with your CPS created questions. You can create CPS
Challenge Boards before class, so that you can simply engage the activity when your students
arrive. To create a CPS Challenge Board, follow these directions:
1.
2.
3.
4.
5.
6.

Open CPS from your desktop icon.
Click the Prepare Team Activities tab.
Click Challenge.
Click New in the Activity group. The CPS Challenge Board Info window appears.
Type in a title for your Challenge Board.
Type in a title for each category. You can come back and edit these later if you would
like.
7. Click OK. The CPS Challenge Board window opens.

•

The top left pane displays all of the lessons or standards in the open database.

•

Use the Lessons or Standards tabs above this pane to choose between lessons or
standards.

•

The top right pane displays the point values under each category. Each point value
button also displays how many questions it contains. For example, the point value
button 10 – 0 is assigned a 10 point value and has 0 questions associated with it.

•

The bottom half displays the questions in the lesson you select from the top left
window.

8. Select a lesson or standard from the top left pane. The questions appear in the bottom
half of the window.
9. Use one or both of the following methods to populate the category and point values with
questions:
Method 1: Populate a Challenge Board with Specific Questions from Lessons or Standards
•

Highlight a question or multiple questions (use the Ctrl key to select multiple, nonconsecutive questions) in the bottom half of the window that you want to drag to a point
value in a particular category.

•

Drag the question(s) to a point value until the pointer is over the point value.

•

Release your mouse button to drop the question(s) into that point value. The point value
button display changes to represent the number of questions you just dropped into the
point value.

•

Repeat for as many questions as you want to add to the Challenge Board.

•

Click the File menu item and the Close command to close the Challenge Board and
return to the Prepare Team Activities tab.

Method 2: Populate a Challenge Board with an Entire Lesson or Standard of Questions
1. Click and highlight the name of the lesson or standard in the top left window that you
want to drop into one of the categories.
2. Drag that lesson or standard to a category until the pointer is over the category name.
The category name depresses slightly.
3. Release your mouse button to drop the entire contents of the lesson or standard into the
category. The questions equally and randomly distribute in the point values. Point value
buttons change to display the number of questions that button just received.
4. Repeat for as many lessons or standards as you want to add to the Challenge Board.
•

NOTE: You can use a combination of the above two methods to drag and drop some
questions to point values, or drop an entire lesson or standard of questions in one
category. Alternatively, you have the option to right click a question and distribute it
to a category or specific point value by using the context menu that appears. The
option to preview the question is also available in the context menu.

5. Click the File menu item and the Close command to close the Challenge Board and
return to the Prepare>Team Activities tab.

Play a Challenge Board
1. Open CPS from your desktop icon.
2. Click the Engage Team Activities tab.
3. Click the Challenge icon on the left side of the screen. Your available Challenge Boards
appear in the right-hand pane of the screen.
4. Select a Challenge Board from the right-hand pane.
5. Click Engage in the Activity group. The CPS – Session Setup window appears.

6. Click Start. The CPS Challenge Board Delivery window appears.
7. Click on a point value. The question and answer options appear on-screen.
•

If you would like to change your feedback settings, click the Feedback Options
icon

.

8. Click the Start button on the question feedback grid. If you have the Auto Start the
Question option selected in the CPS-Delivery Options window, students can begin
responding without you clicking the Start button.
9. Teams press and release the button that represents their desired answer. If a student or
team wants to change their answer, they simply press a different button for the same
question and the corresponding on-screen response pad number flashes yellow.
•

NOTE: If you want to see question or answer graphics better, click once on the graphic
to enlarge it to full screen. Click again to return the graphic to original size.

10. Click End to end the response cycle.

11. Click Close to return to the challenge board and select a new point value. The center of
the challenge board displays each team name, their pad ID, and their cumulative points
earned.
12. Repeat the steps for each question you want teams to answer.
13. Click File and Close when you have completed the challenge board. Performance data
for each team is available on the Report Reports tab.

